Secondary structure
prediction



Secondary structure prediction

Amino acid sequence -> Secondary structure

Alpha helix
Beta strand
Disordered/coll

70% accuracy 1991, 81% accuracy in 2009



Secondary structure prediction

Limits:
Limited to globular proteins

Not for membrane proteins



Secondary structure prediction

Applications

Site directed mutagenesis

Locate functionally important residues
Find structural units / domains



Secondary structure prediction

Techniques

Linear statistics
Physicochemical properties
Linear discrimination
Machine learning

Neural Networks

K-nearest neighbours
Evolutionary trees

Residue substitution matrices

Using evolutionary information = Multiple
sequence alignments.



Secondary structure prediction
Jnet

Cuff and Barton (2000)
Neural Network

Training set: 480 proteins (non homologous)

Construction of MSA for each using BLAST



Secondary structure prediction
Jnet

Neural network

Ni Neuron i, Nj neuron j
Wij weight from Ni to Nj
Wij

Ni =——>{Nj

Signal forward propagation
Output from Ni * Weight Ni to Nj
Input to Nj is Ij = Oi * Wij




Secondary structure prediction
Jnet

Neural network

Ni Neuron i, Nj neuron j
Wij weight from Ni to Nj

Wij

Output layer

Input layer



Secondary structure prediction
Jnet

Neural network

The network receives input values

[ wp| Nj

Ij = Nj
, Output layer

[ K
Input layer



Secondary structure prediction
Jnet

Neural network

Signal forward propagation

Sum of outputs from Ni, Nj, Nk



Secondary structure prediction
Jnet

Neural network

Compute the error

Desired value is 1, Oz is 0.8
Error is = Oz - desired value = 1-0.8 =0.2



Secondary structure prediction
Jnet

Neural network

Error backpropagation

Weights are modified so that the result is a
bit closer to what we wanted



Secondary structure prediction
Jnet

Neural network

Hidden layer

~

Output layer

Input layer



Secondary structure prediction
Jnet

Neural network

Input layer: read a sequence CTEIL. ..



Secondary structure prediction

Jnet
Neural network
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Input layer: read a sequence CDEKL. ..



Secondary structure prediction

Jnet
Neural network
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Input layer: read a sequence CDEKL. ..



Secondary structure prediction
Jnet

Neural network

C U TIAHAdO

Input layer: read a sequence CDEKL. ..



Secondary structure prediction
Jnet

Neural network

Alpha-helix §<
N
-

Output layer: structure
Desired output: known structure



Secondary structure prediction
Jnet

Neural network

0.4 1
Alpha-henx§< 06 0
0.1 0

N
-

Output layer: structure
Desired output: known structure



Secondary structure prediction
Jnet

Neural network

0.4 1
Alpha-helix(é{ 06 0
0.1 0

N
-

Error backpropagation = weights are modified



Secondary structure prediction
Jnet

Jnet architecture Sequence to structure network

OYNdHTATAHdOdHdY'T

Input layer = window of 17 residues
Hidden layer = 9 neurons
Output layer = 3 neurons



Secondary structure prediction
Jnet

Jnet architecture

MOVNd HTATAHADAHIVYTA
O



Secondary structure prediction
Jnet

Jnet architecture Structure to structure network

MOVYNd A TATAHIADdHdY 1A
o
elefo(eole[o(e[o[oole)=ltol=2=lete

ole(ofe[o[e[o[e[ofelote) =)=z =0=Tete

Input layer = window of 19 residues
Hidden layer = 9 neurons
Output layer = 3 neurons



Secondary structure prediction

Input sequence(?

Geoff Barton,
University of
Dundee

Jpred 4

Incorporating Jnet

A Protein Secondary Structure Prediction Server

MQVWPIEGIKKFETLSYLPPLTVEDLLKQIEYLLRSKWVPCLEFSKVGFVYRENHRSPGYYDGRYWTMWKLPMFGCTD

ATQVLKELEEAKKAYPDAFVRIIGFDNVRQVQLISFIAYKPPGC
s

Advanced options (click to show/hide)

\ Make Prediction ‘ I Reset Form ‘

Primary citation: Drozdetskiy A, Cole C, Procter J & Barton GJ. Paper in preparation
Previous: Cole C, Barber JD & Barton GJ. Nucleic Acids Res. 2008. 35 (suppl. 2) W197-W201 [link]

bioscience for the future
DUNDEE

Cole et al (2008) Nucleic Acids Research



Secondary structure prediction

Jpred

Uses algorithm Jnet2.0

Three state prediction

Alpha, beta, coll

Accuracy 81.5% (2008)

But if no homolog (orphan sequence) 65.9%)!

PSIBLAST PSSM matrix

HMMer profiles (instead of aa frequencies)
Multiple neural networks
100 hidden layer units



Secondary structure prediction
Jpred

First, search against PDB sequences using
BLAST (but only for warning)

PSIBLAST search of UniRef90, 3 iterations,
Alignment of hits (filtered at 75% id)

Profiles from alignment (PSSM and HMMer)
Profiles are input to JNet

Alternative: user provides alignment (faster)



Secondary structure prediction

Advanced Jpred4 usage
Jpred 4

ncorporating Jnet

A Protein Secondary Structure Prediction Server

I I 0 I

Input seq uence(?) MQVWPIEGIKKFETLSYLPPLTVEDLLKQIEYLLRSKWVPCLEFSKVGFVYRENHRSPGYYDGRYWTMWKLPMFGCTD
ATQVLKELEEAKKAYPDAFVRIIGFDNVRQVQLISFIAYKPPGC

Advanced options (click to show/hide)

..orupload afile ? | Datei auswahlen | Keine ausgewanit

Select type of input ¥/ Single Sequence (click to select format):
Multiple Alignment (click to select format):

Skip searching PDB before prediction (*) Check to skip
Email address (optional) )

Query name (optional) ?)

\ Make Prediction ‘ Reset Form ‘




Secondary structure prediction

Jpred
output

Results

After much trouble and strife, Bob the scheduling penguin has retrieved your results! Rejoice. For your pleasure the
following viewing options are available. You may bookmark this page for future reference although data is not kept on
the server for more than two days.

n SVG - displayed below:
1IO ZIO 3I3 -‘:3 SIJ ?:3 TIO
P_X49096mL/1-3TMTT SASSHLNKG I KQVYMSLPQGEKVQAMY IWIDGTGEGLRCKTRTLDSEPKCVEELPEWNFDGSSTLQSEC

« View results summary

T E e B T e e N N
Lupas_T14 - - - o o e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e
R E e R T e e I I R

jnetpred e D — —

INETCONE ‘ -. - ‘ IA-_— -.-

00088754307888088610888607880003032336458033211122208777766126777 7777777
JNETSOL25 - - ------ B---BB--BB-8--5--B-B5E8685558888-- 5- 58B8--58---5--B5B8E85555888888- BB- -
JNETSOLS = = = = = == e o m e e e e Bevoomm-n- B-B8-BBBB-------- B-B--B----ommnn- E85858B8BB- 88- - - - -
IJNETSOLO - - - - == s e ccccmmmeaaaaaaaan - - T - e
JNETHMM =~ ————— G ————— ————f —— G
JNETPSSM = G ——— E—
JNETJURY . *rrx = rEzzzzEETEE:
»
. ew full results in HTML
. simple ults in HTML
* View results in
* View results in PDF

« View results in Jalview (Links to a separate page with the Jalview Java applet)

« View full multiple ence alignment with d insertions
. v full multiple out

. v everything

o Getall (but PS

This Jpred prediction was made with following.

Jnet version: 2.3.1
UniRef90 release: 2014_07, 09-Jul-2014




Secondary structure prediction

JPred
Jpred output / Jalview

=10l x|

File Edit Select View Format Colour Calculate Help
120 130 140 150 160 170 190 200

I AGLDCCCLAL LPGLWSVVS TE a]

LrBHLHLPPEREK FVVAiL AU s T+ e o TR
LPSHLOLPPERES FVVAALEAL SWHL | HEQMPL
LPTSLRVPP D FVVM!I AL SWHL | HDRLP |
LPSSLRIPS HLI.TFIC Al vlv LLONQLPL

QUERY G.AAL QSLP LARALA
UniRef20_UPI0000F 20790 GNAM I QS LACALA
UniRef230_UPIO000ECCT 28 GIEVM QSVMTLCRALA
UniRef30_Q4S7T2 PGFY¥SRVLSLCRALS

LWVvAS
LVLL
LLLL
LLTMN

L AVLDCCCL LALPALWNMLSS | E
L AALDCCCL LAQOQPSLWNLLASAA
ALSCLCLAL QP CVWNKLSIEPE

< - r

UniRef30_URPI0000DB 7 10DE NESVIWDVLFMLIPAVKI MKTL LAKYAKIDKKSEE LAIFAVLCL LT YWMYVYKKLKPRNMEL - ALSCA EILKHPGPNKMFGENT
UniRel30_UPIDO00DSEEES - - - - - - - - - - - oo v v oo oo - STV - - - - - - - S.NSEVLV FGVICL INILIDRKNFNLNIIL AIHCCE!VLKEKKLFGVLNQES
=l
LUPE5 21 = = = = = = o s e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e eeeeeeeeeaeesaeeaaeaeeeeeaeeeeeeeeee e
(T o - T T T IR P
LUPAS 28 - = = = = = = = s e e e e e e e e e e e e e e e e e e e e e eeeeeeseeeseeseeeeeeeeseeseeeseeeeeeeeee e
jnetpred _— —
JNETCONF
7887022788879900000000086107888788775607280000000000000008610672888607800000000861577887776454
JNETSOL25 - - -PBB-BBBBBBBBBBBBEBBBB- -BB--B-B------ ppB-BBBBBBBBPBBBBBB---B-BBBBB-BBB-BBB-BB----BB-BB- - - -
JNETSOLS - - - - - - - - BB-BB-BB--BB--B--B-- - - - eeebBBB-BB-B-B- - - - - - - .- B--BB--B--BB-------------
JNETSOLD - - - - - = - - o - e e i o i i -sssssssasaaaaeaaaac-- =T = S =Y -
JNETHMM -
JNETPSSM —— (e
JNETJURY = = = =

Kl I 0

Sequence position 22

IJava Applet Window N



Secondary structure prediction

JPred

Jpred output / view all

QUERY ¢ KDWYVHLVKSQCWTRSDSALLEGAELVNRIPAEDMNAFMMNSEFNLSLLAPCLSLGHSEISGGOKSALFEAAREVTLARVSGTVQQI
UniRefS0 UPIOOOOFZD790 : QDUWYLSLVKFQCCTKSDSALLEGAELVNRIPPGELTPFMLSKEFNLCLLAPCLSLGVREISSGOSSSLFETARSVTLDRVASLVQQI
UniRefS0 UPIDOODECC?ZE : KDWYMSLVRSQCCIKSDSALLEGAELLNRIPQPDLNSFMNSKEFNLSLLAPCLSLGMNEISRDOQKSSLFEAARRVTLDHLSATVLNI

TniRefS0 Q457TS9 : KEWYVALVKSQCCVHGDVSLLETTELLTEKLPPADLLSVMSCKEFNLRLLCPCLSLGVQRLVRGOGSLLLETALHVTLEQLAGATGLI
UniRefS0 UPIONOOODE7IDE : RNWFLSQVKLRCCHNSNNYNLSEAAQLLKVLDFEDCLGILSSKEFNIAILKPCIILGVRSVEKCQKSPLYSAAKQCLLDHIHYVIDLI
UniRef90 UPIOOOODSEEES : KNWYLAQIREKCNSK-—-—-—-—- ETAQLLTRLDYEELCNFLRNADFSKVVFKECLSV-——————————— PTLEDSERFDSRFLTQIYDL:

P le——————— 11-——————- 21l-——————— 3l-——————- 4]l-—————— Sl-———e 6l-——————— l-—————— 8l-——-—-
OrigSeq : KDWYVHLVKSQCUTRSDSALLEGAELVNRIPAEDMNAFMMNSEFNLSLLAPCLSLGMSEISGGQKSALFEAAREVTLARVIGTVQQI
Jnet : —-HHHHHHHHHH------- HHHHHHHH----HHHHHHHHH----- HHHHHHHHHHHHHHHH-—-——=—=-- HHHHHHHHHHHHHHHHH--
J hrara : —-HHHHHHHHHH------- HHHHHHHH----HHH-HHHH------ HHHHHHHHHHHHHHHHH-—--—--- HHHHHHHHHHHHHHHHH--
jpssm : —-HHHHHHHHHH---—-—==—=-- HHHHHH----HHHH-HHHH----- HHHHHHHHH--HHHH--—==—=-- HHHHHHHHHHHHHHHHH--
Lupas 14 I e et et T et L
Lupas 21 I e et et T et L
Lupas 28 I e et et T et L
Jnet_25 : ——-BB--BEE--BE----BBBEE-BEE-BE--EBE-BE--BE-EBEE-BE--BEEEBBEEE-BEBBEBEE--B-——————- BEE-BEE--BBEE--EBE-BE--1
Jnet_S5 P m—————— B---B-—————- B--B-pB------g--gp-g--g---B--g-p---p-------p---B--B----B--B-—-—--
Jnet_0O P mm————- B———————m e B————————— B-————————— e B-——————- B-————mmmmmrrrre -

Jnet Rel : §27999995995514677750012145327754430067503757424331321200101000777632799999999999995722!




Secondary structure prediction
JPred
Jpred output / PDF output
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Exercise 1/3
Jalview 2D prediction

Starting Jalview
Open Firefox with JRE (from ZDV)

Go to http://www.jalview.org

Click the pink arrow “Launch Jalview Desktop”

You can close all the demo windows that
appear



Exercise 1/3
Jalview 2D prediction

Load an alighment

Use MR1_fasta.txt
This is an alignment of a fragment of the
mineralocorticoid receptor

Open it from File > Input alignment > From file
(Hint: You can load it directly as an URL, e.q.
https://cbdm.uni-mainz.de/files/2015/02/

MR1 fasta.txt)

The alignment has its own Menu tabs
Try Colour > Clustalx
to see conservation



Exercise 2/3
Jalview 2D prediction

Web service -> Secondary Structure Prediction -> Jnet
secondary str pred

No selection (or all sequences selected) = Jnet runs on top
sequence using the alignment (fast)

One sequence (or region) selected = Jnet runs on that
sequence using homologs (slow)

Some sequences selected = Jnet runs on top one using
homologs (slow)

Try with no sequences selected



Exercise 2/3
Jalview 2D prediction

If this doesn’t work you can run directly
MR1 fasta.txt on jpred4.

Use the advanced option

Upload a file option

Select type of input = Multiple alignment (use
format FASTA)

iIck the skip PDB search option

here is an option to view output in Jalview




Exercise 3/3

Jalview 2D prediction

Annotations:

el upas_21, Lupas_14, Lupas_28
Coiled-coil predictions for the sequence. 21, 14 and 28 are

windows used.

JNet prediction on FER3_RAPSA using alignment from MuscleWs alignment of Uniref50 Se... o* @& [
File Edit Search View Colour Calculate

100 110 120 130 140
LP*SCRAGSCSSéACKVVSCSVbQSDQSFI.DDI.)QIAECFVLTCIAAYPTSDVTl B

FER3_RAPSA/1-96

..........................................................

JNETCONF M
157887753307 7666567851599722110257655555520001443 )
JNETSOL25 - ---8-BEE-EBEBEBBEE--B-BB----vcnowwnn- Beccccanaa EEBBEE
JNETSOLS == =====---~- - Bo--mmmm e E-BBEE
INETSOL0 "~~~ =~==="=rro=sceconarecssrenasresasreesseesnrra=s B-BB
JNETHMM S - —
JNETALIGN =% k= L 4 —
Jpred — —
K | »
Eeauence Eosnlon 148 I




Exercise 3/3
Jalview 2D prediction

Annotations:

¢JNETHMM, INETALIGN: predictions using diff profiles
eJnetpred: Consensus prediction.

Beta sheets: green arrows. Alpha helices: red tubes.

JNet prediction on FER3_RAPSA using alignment from MuscleWs alignment of Uniref50 Se... o* @& [
File Edit Search View Colour Calculate
100 110 120 130 140
FER3_RAPSA/1-96 LPYSCRAGSCSSCAGKVVSCSVDQSDQSFLDDDQIAEGFVLTCAAYPTSDVTI -
V] T T30 S '
Lup I
TR T30 Bl
jnetpred S —
JNET CONF M _‘
157887753357766656/78515997221102576555555200014438999
JNETSOL25 - ---8-BBE-BBBEBBBEEB--B-BB---------u-- [ EBBBEE
JNETSOLS == ===-=-=--~-~ Bo-mmmmm e o e E-BBEE
JNETSOL0==========cccaacccassccsesccasracasrccascasacc=as B-B6
JNETHMM —— -
JNETALIGN =% L - ——
jpred S —
‘I I »
Eeauence Eosnlon 148 I




Exercise 3/3

Jalview 2D prediction

Annotations:
¢ JNETCONF

Confidence in the prediction.

JNet prediction on FER3_RAPSA using alignment from MuscleWs alignment of Uniref50 Se... o* @& [
File Edit Search View Colour Calculate
100 110 120 130 140
FER3_RAPSA/1-96 LPYSCRAGSCSSCAGKVVSGSVDQSDQSFLDDDQIAEGFVLTCAAYPTSDVTI -
lupas 21~~~ """ T T T T T T T T T TS T ST ST ‘
UETTWE TS T i
TR T T30 Bl
jnetpred = =
157887753357766656/78515997221102576555555200014438999
JNETSOL25 - ---8-BBE-BBBEBBBEEB--B-BB---------u-- R EBEBBEBE
JNETSOLS == ==-==---~ B--mmmmmm - Br-mmmm e e E-BEEE
JNETSOL0==========cccaacccassccsesccasracasrccascasacc=as B-6B
JNETHMM — - —
JNETALIGN =% L - —— 2
jpred S— -—
K Z D
Eeauence gosmon 148 I




Exercise 3/3
Jalview 2D prediction

Annotations:
¢JNETSOL25,INETSOLS5,IJNETSOLO

Solvent accessibility predictions - binary predictions of 25%, 5%
or 0% solvent accessibility.

JNet prediction on FER3_RAPSA using alignment from MuscleWs alignment of Uniref50 Se... o* @& [
File Edit Search View Colour Calculate

100 110 120 130
1

140
FER3_RAPSA/1-96 LPYSCRAGSCSSCAGKVVSGSVDQSDQSFLDDDQIAEGF VLTCAAYPTSDVT! -
(T w T T30 Sttt
(T WE TS I Tl
TR T30 Bl
jnetpred

JNETCONF

1578877533577666567851599722110257655555T 443
JNETSOL25 - ---8-BBE-BBBEBBBBEEB--B-BB------u-uu-- Bovoceenna- EsBBER
JNETSOLS == =====---~- - Bo--mmmm e E-BBEE
JNETSOLO == === ===~ =-- - - - - - - --------- -8B
JNETHMM S
JNETALIGN =% - L 4 —
Jpred S —

o

Eeauence EOSﬂth 148 I



Exercise 3/3
2D prediction of khnown 3D

Obtain the sequence of the human glutamine
synthetase.

Run BLAST with the human sequence against:
1) the archaea Methanosarcina

2) the bacteria Escherichia coli

3) the fungi Pseudozima Antarctica

Get the best homolog, align the sequences
(including the human protein, on top) and use
the input in Jalview.



Exercise 3/3
2D prediction of khnown 3D

NCBI BLAST against single species is faster!

— BLAST®

” Home RecentResults Saved Strategies Help

» NCBI BLAST/ blastp suite Standard Protein BLAST

blastn  blastp blastx tblastn thlastx

[ BLASTP programs search protein databases using a pro
Enter Query Sequence prog " B ap

Enter accession number(s), gi(s), or FASTA sequence(s) & Clear Query subrange )
From
To
Or, upload file Datei auswahlen | Keine ausgewahit *)
Job Title

Align two or more sequences §)

Choose Search Set

Database Non-redundant protein sequences (nr v @
Organism . _ —
—- Methanosarcina (taxad 2207} Exclude T
enter orga ! 1 1ax ' op [axa pe sl J

Cunlicda .- . Lin & essen



Exercise 3/3
2D prediction of khnown 3D

Obtain the sequence of the human glutamine
synthetase.

Run BLAST with the human sequence against:
1) the archaea Methanosarcina
2) the bacteria Escherichia coli
3) the fungi Pseudozima Antarctica

Get the best homolog from each, align the
sequences and use the input in Jalview. Put
the human protein on top.



Exercise 3/3
2D prediction of khnown 3D

Load the alignment in Jalview and run web
prediction.

Alternative. Run the alignment in the Jpred4
server. (Hint: You could run the human
sequence alone but that will search for
homologs and will take very long)

Compare the prediction with the known 3D of
the human protein (open it in Chimera, File >
Fetch by ID > PDB 2QCS8)



Exercise 3/3
2D prediction of khnown 3D

We need to hide all chains except one.

Select one of the chains (ctrl + click on a
residue, then arrow up). Invert selection

(press arrow right).

Actions > Ribbon > Hide
Actions > Atoms/bonds > Hide

Select the chain and focus on it
Actions > Focus



Exercise 3/3
2D prediction of khnown 3D

Compare the output of jpred/jalview 2D pref with the 3D structure of this
protein.

For example, locate a predicted helix or beta-strand in Jalview. Find out
the start and end positions hovering over the human sequence with the
mouse (the numbers on top of the alignment are different from the amino
acid positions in each sequence).

Color the corresponding residues it in the 3D view using
Select > Atom specifier

And ranges: e.g. :113-126 (predicted as helix)

Actions > color > red

Apply color some helices red and strands in green.

Do you see differences? Where are they?
Would you say that the 2D prediction was reasonable?



